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Kl 3.2 Quartus Prime K 7 5

1E#E File>New Project Wizard iy 4, FI F [0 5 2 5¢ i T 82 (9 2 57, # A an 1Al 3. 3 Jr
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PEASE 4 Wik B R AR H L A 3.7 Fros, B ese B A B A5 B R, AR
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3.1.3 BERitEA
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REE 44 . A SRR S| a4 Th R TE B 0 PR SRR —1,++-,0],
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H B & B 45 R il as i R 830 F . Quartus Prime B0F o (59 2 198 28 BUA 4 4 3% F1Ar 45
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(D 2 #Hr 5%:4 (Analysis & Synthesis) : &3 SCPEHEAT 40 B TR A5 i A SCOF A5 45
15, X 1) 3 B4 4 J& Quartus Prime 3% 1 Processing S8 B F (Y Start\Start Analysis &
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(2) i@ ML (Fitter) : 7Eid Fo o #2 v, 58 BT 32 48 & 18 b 09 45 Jmy A 2 e 2538 > 1Y P &6
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FEEIbR & B DA M T2
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£ o
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Y VEERAE T B A W R A Bt . X TR Ryt B 4 A0 G R AT DL S B A B IR]
Y= e R R & SN Y= R e

A5 G 13 2ok A2 b, W B I VR AT T 5 Message 5 B2 H Y Processing 7 & AL 7R
2 S 5 A 10 A B AR R 038 B 5 SO g e A R N T R R P AT X
BRAE B2 A 8h s 6 B R R SO AR B 7 L AR DR R R A B B R o B AT B
M TR ARG R RE B 2 5 i B B T SO X N IS N T R R
HF A ) R G A G R T TR G R . I SRR R — SO AT G R O B K A R
S DU R A& R0 5 0 D DU 07 A 36— SR A iR A 8 R AT 08 ok L 48 ol 58 B =2 )5 T A AR A7 6 AT PR 4
PR, K Z 800 O Ja b B0 B 1R 0 B R AR 2 i i i A A 1R B 5 R I A AR R RS

(5) Wi H g e HAh 8B . AEXT I H SEAT i 17 22 A0, T LUAR P8 300 B 75 oK A — 2L A 6 i B
s H Ande 4 BB R R,

HEFESE L Assignments— Settings #7423 3 H 101 H 41 B XIS AE , W&l 3. 13 i, ol
Ve T HAS o BIARFT I3 B X UG HE . 8% B % 3 HE Hh 22 M358 331 Sy 1% 8 43 2% (Category) » £ il
A A A TEAN R
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3.13  BEE X HE

General . T H T0JZ2 & i1 5014

Files: il H 34

Libraries: Tl H J# ;

Operating Settings and Conditions: T H T/F L JE TA/EIRE ;

Compilation Process Settings: Z i 4b #l &% 1% &, 0] LU 300 H g 2% 1% & 2 4% I 17 4b 1
A LT (R4S TR 1 g 5 LR T A

EDA Tools Settings: 5 =J57 EDA T B B %I ;

Assembler: L4 E .

WEXIENES MAA Device FC B 4 6, 55 5 9 B Ax g 08 B0 B 15 B, 4% 15 i &2 435
HEANTAL 3. 14 o, it T2 B AR e

TE XU HE T By Device and Pin Options.. . %20 2 500 H g 2R A5 I R 40 e & . an /& 3. 15
iR, BEELMEE SR LGMAREKEESHE, ERESEDPNSENL T M
Description f#f iR U W 3k 47 BRI & . RGN General £ 5 Auto-restart configuration
after error, B W ECE S WIS RS E S L B #E R . JTAG M P A ] iy P dwiid 4 2
i JTAG $HE 1 3kAS,

Configuration Bt B & W 41 & 3. 16 fif 7~ . Configuration scheme I N 4 /i 0 H B &
O G E 7 2L B HE Active Serial (E B ITHLED (Passive Serial (42 BATHECED . LA I



& 3. 14
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S| R
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& 3.16 g B pE I

WA RARE R TR s . 0 SR A S B B AR L&, %8 Use configuration
device HHYHAARL S, 41 EPCS1EPCS16 45, WA 6 £ Auto BEAT A hik £, PS 7 U T
EPC1.EPC2 it & J5 3, Generate compressed bitstreams 3% W 7] X} i & SC{F #4757 K 45, H
Fots i R A% VR0 R 46 J % T 5 S O 52 I i s R AT I

Programming Files % th SCAFBC &, 2] T e £ 9 B2 S 72 A kg X, X T PS B
i E )7 X, Quartus Prime #4523 M4 H AR08 8545 58 A 8] 09 e & SO L ) T
SRAM H#5 3 sof) \SRAM U (. psoD) 8 4 #2 H AR ST . opol) o AT 77 A= — 3k il Fic &
SCAFC o hexout) o AT BE RS B 3tk A0 3t 41k 326 99 07 30, 2R SO R AT T EPROM AL R HLAY
HLH FPGA L HLEK

Unused Pins AR 51 IB &, AL 8 Tt i 4 R AR A 5 IR & . w] %R {8 51
JICE 5 AR A As inputs tri-stated (Bi A = &) . As input tri-stated with bus-hold
circuitry CELE B AR B 005 A =75) . As input tri-stated with weak pull-up (B 55 F
PR H A =25) . As output driving ground (i tH #231) . As output driving unspecified signal
Chin iR B (R 5 o LA BB R A X 42 Jm A T 5 1 IAV R AT G &, s SR — 5| JIAVC &, wl
Assignment editor #FT L&,

Dual-Purpose Pins 4 Z U REG I I E . 78 B Ar.ts i e & 58 iU, B2 26 e & 51 1] 17



B IIREWE L W nCEO . nCSO,ASDO. AR A Z2 I RES 1IN [F], X T 2 D GE 5| Al L
BE R 1/ O 5 s A =355,

3.1.5 NEpPE

XF 35 H G PR 5 IS, BB 0 B R A e AT O B, B AR BT SRR A BT B
DIRE R 7 E AR

74 B AE A A Quartus Prime #F RUA A R [\ 948 4E, 22 518 K. 7E Quartus
Prime 9. 1 Z A (2% MAXPLUS [ (9 F A 47 05 5 AL 002 )5 FOPE A FH4 5 s 1F
Quartus Prime 9. 1 MUA Z B A 19 07 B H A 3CF TestBench, H 3B SCHF. vwi,
vwi X R R m I S (Vector Waveform File) , /& Quartus Prime {5 E i A L1t
SR RO P A — R T N R SO R A AT N AL IR A S DL B A
Fl AR B 5 5 5 . b AR B R oK m R A BRI O SR A T B
A TKB 847 5 A K &, T T AR 5 19 e 2 m 8000 A Jal 8 . A B it 8% J 17 HL 25
Fr il . BIAE Quartus Prime9. 1 A Z J5 05 B AL 200 % 3% ModelSim-Altera 355 = 7 {Jj
HAK M ModelSim PE/SE. 7E {5 H 22§ ¥ 3% 1 A8 Bz 49 9 328 3C 44 (TestBench) , 38 i % H
Quartus Prime [ ModelSim-Altera 805 = 515 B ModelSim #4741 E .

ModelSim 1} B4 B % #:%+ VHDL #1 Verilog HDL, i T 4 45 # % J Quartus
Prime JEUP P 531 05 2%, BTG vk B #H AR B B9 ModelSim-Altera 855 = J5 {5 H 3 A
ModelSim PE/SE H# #4705 &, Fr L HBEHEE Quartus Prime 4535 5 7= 42 09 SCHE T M=
ModelSim PE/SE # 4 b #4705 B K .

1. BIBKEEXH

HRIK 3 #& File— New — Verification/Debugging Files— University Program VWF £y
A 3,17 iR,

2. BEHERE

75 FL R TR] R RE AR 4R 95 0 B0 TR B 7 O E L K
Wik # File>Edit—>Set End Time fir 4, A5 H %
BN 1. Ops. WA 3,18 s,

3. AMAET R

TE A5 B 2Z i 7 AR R SO B I 2 AE
5, %&£ Edit=>Insert—Insert Node or Bus #72, jifi
ANk 3. 19 PR g 1,

M O Node Finder #% #1, 3 5 40 &l 3. 20
iRyt g el O, By s SR TR 20 2 A A
07 ZLA 5 50 2 AR B A . PO
£ S R | W SR 1IN 8 rC T 7S5 1 (SRS
Jn. B S 3. 21 Fron. BEEE A A
G EOAER 2 0 T B R S 2R, RN AR A
R K317 QIEIE O 2 iF
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63,18 BLE A ELE5 T ] Kl 3. 19 B EE A

& 3.20 SuEd o

B 3,21 WIS B A

4. RMHBES

TR AR AT B IE A 0 0 FLAE R EAR R BT TR B D RE BOR N B AR T R R — 2
BN MBUNES . A TEREAGS BA clock U2 G S UM 855, A A2k
ST P E SRR A TR . b X R AR, 0 RN ZH 0,1 £niZiE
1,72 Fon B, L3RR 55 0, H R85 1 GRS HL b XU 455 i BB R ECR 50 L INV 3208
B, C R0 AR B bR s i, 2 3R B ELAR 5 3R0R 7 30 R BEE BEALEL, A TR 1 4%
B8Rl . NS 38R File—>Save i & R AE5 H SO
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5. IZ1THHE

i Simulation—>Option, %4 Run Functional Simulation(ZJ&E5 E) 8 Run Timing
Simulator (A [ 4/ 20 . 40 &l 3. 22 v . B )75 B0 AT DA o 0 4 tE 15 5 5 5 A (S 5 09 28 B
KFR, DRl BHE R KA 3. 23 i,

!

e

&
=
mt

& 3.22

g
NN

Kl 3,23 hBE(h A4
6. ESHHE
T AE TR LG 0] LUK B B MF S 4L R 2 IR g . AR B H QO~Q3 mT L
3 2L F A o o B AR S L RS S 7 1, Q3 i AR ] R
FHA R B 25 R A R WoR o 0~F PRI A . 43 20 )5 vk 6] i i vh 5 40 4HLAR 5
fiili Grouping—Group. 3 i W 3. 24 Fron Y FLiT . Group name HE XN Q. Radix % #
4 Unsigned Decimal, iy OK #4105 E 45 B 3. 25 FiR,

K 3.24 {554

3.25 SrdljEfh AR

3.2 f¥ H Quartus Prime # 17 VHDL &1t

Quartus Prime ZFF 2R ATE LA B EZ IR A H VHDL #7 8F R 5 kit
R R,



3.2.1 VHDL XX
& i B 5 R Jy Qs ad B — B0 76 3 2l SO e 8 VHDL File BI AT, 4ni&] 3. 26 s .

B 3.26 ¥ VHDL &1l

T L B SRS ), A48 VHDL it it . 78 VHDL SCfFEh 4w S nil 3.1
AR
[%13.1] VHDL X aftas .

library ieee;
use ieee. std logic 1164.all;
use ieee. std logic unsigned.all; ——
entity cntl0 is —— SR
port (clk: in std_logic;

rst n: in std_logic;

counter: out std logic vector (3 downto 0));

end cntl0;
architecture art of cntl0 is —— SEFg R
signal temp: std_logic_vector(3 downto 0);
begin
process(clk, rst n, temp)
begin
if rst n='0' then temp < ="0000"; —— B EE
elsif clk'event and clk = '1' then
if temp="1001" then temp <= "0000"; —— RN F 9 B A M

else temp <=temp+ '1l';
end if;

end if;



counter < = temp;
end process;

end art;

TRERESRFER. BEIITTREAGE, K TKNH 55— E L, Bl Quartus
Prime Ml ModelSim-Altera B& 15 B L 1% 7 ikt 2l 5 H i b s 19 45 5 5 =X,

3.2.2 ModelSim-Altera T3

Mentor 2% 7 ) ModelSim b 5 #4575 B9 HDL i 5 05 B & RE 4R 1L A I i py B
PRI, Sl B — (0 B N B S0 H VHDL Ml Verilog IR G5 E A5 B 8%, B R M H LY
HIEHAR (Tel/ Tk AR R — B ELRAR , G 198 f5 508 B2 P 4 i i AR 55 & o6 (8
TR 1P %, AP A BE 5 A P 3 1o R P e Al g2 i e i B & FPGA/
ASIC Bt By E k7 B,

ModelSim 43 JLF A [F (9 it 4< : SE.PE.LE #l OEM, Htf SE 2t 55 %A i A<, i 48
JWAE Actel,Atmel.Intel,Xilinx LA M Lattice & FPGA | B+ T H iy -2H OEM it
A, ModelSim SE & FEMA S , 2 P 8 i 9 K I IRUAS . X FEXT Verilog #1 VHDL i 5
PR AU E . BT RZERRASN , Mentor A Al i J 45K FPGA | i #24t OEM WA . XE /&
o Xilinx A A $AER OEM M. a4 Xilinx 2 6 9 S0 ; AE J& 28 Intel 22 2L OEM
R, A Altera 23 @ B SCHE s 78 HRRE 28 @l OEM WUHE AT 05 B AS 75 22 45 3R % 28 7 Y
JE SO AR SR B S PR BB R AR AR LS J T SE WU

3.2.3 TestBench ®RE

WA R A ModelSim-Altera #4705 B , 75 2 A9 05 B SCHF4RE TestBench, A7 H 45
A Quartus Prime BEAR 4 5 TestBench 3C#F I 58 i 0 it F2 K 45 5. 1 40 68 A
TestBench 5 76 5 22 395 P AT 41 .

Quartus Prime FAFMRAE BT S AT 77 Az — 4> TestBench BB, IZ A C 4 45
R SCAF R TP 5 04, I 58 T A SR 5 B RE SC, T AT AR BEAT AR A B Al ¢ A
KW F = 77 A

PEFE Quartus Prime SE B Processing—Start— Start Test Bench Template Writer iy
2, J8 8l TestBench Bk, WA 3. 27 78 . Quartus Prime F| M FE 95 #5528 it TestBench
9 5 BRAE T 208 SO A SR A7 2 S0 b AR B0E T O iA5 B 4 7 T L I 3 S
AE Info(201002) : Generated VHDL Test Bench File E:/QII_Prime_VHDL/Chapter3/
counterl6 _ gdf/simulation/mod--elsim/cnt10. vht for simulation H, #ll & 3C 4 7 4%
s vhe, BRAE ENIE 3. 28 iR .

My TEHR R BT IF = d2 4, MR P5 TestBench At A1 #5882 2% 7T IF 800 61 a1
TestBench B SCIF % SCAFRAEAE TR Fr 76 SCF 92 7« simulation/modelsim/cnt10_vhd_
tst. vht, 30 A S EI 2  TestBench BIAR ST W 3. 2 Fis

(%1 3.21 TestBench #H AT

LIBRARY ieee;
USE ieee. std_logic_1164.all;
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[® 3.27 JB3h TestBench HitRk

3,28 MM A SR E B

ENTITY cnt10 vhd_tst IS
END cnt10_vhd tst;
ARCHITECTURE cntl10_arch OF cntl10_vhd tst IS
—— constants
—— signals
SIGNAL clk : STD LOGIC,;
SIGNAL counter : STD_LOGIC_VECTOR(3 DOWNTO 0);
SIGNAL rst_n : STD_LOGIC;
COMPONENT cnt10
PORT (
clk : IN STD LOGIC,;
counter : OUT STD LOGIC VECTOR(3 DOWNTO 0);
rst n : IN STD LOGIC
)i
END COMPONENT,;
BEGIN
il : cntl0
PORT MAP (
—— list connections between master ports and signals
clk => clk,
counter = > counter,
rst_ n=>rst n
)
init : PROCESS
—— variable declarations
BEGIN
—— code that executes only once
WAIT;
END PROCESS init;
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always : PROCESS
—— optional sensitivity list
- )
—— variable declarations
BEGIN
—— code executes for every event on sensitivity list
WAIT;
END PROCESS always;
END cnt10_arch;

M TestBench BEAR K F , M SO LA Ry 25 SEBR b I SR 3 2 02 7 2B N 3 i il
T, 38 33 YA 55 Rl SO S A v 1 HEAT A AT IR L R SO ) 4 R AR 1 B o g o
LB PRy . — 043 k5 1 0 S A s 11 B N IR A B S 53— A R D S A Y e
L g 11 SR R AR 5 0 S AR g 11— 350, 8 clk L counter . rst_n, Z5 KR A T A
A A 2R R AR A B . 0 R AR AR L T AR A S AT — Ok A T BR A TR 6 3R
PATHERE , Z R IATH TR MG 5 1 A . A6 BA S0 G A DI iy it hil i H s
AN AE 5 o B S S G S S AR — R AT S i AR ALAE S, B AL
100ns,100ns J& 8015 508 5 FE9E P 35 v IR 00 B 4 7= A= o 4] W8 000 465 4 4K P 3 e
TR R 20ns 19 % L clock _period, J ffj H 5S0MHz B # 45 5. 7818 26 i £ A1)
WAIT A4 B8P 55 . B EUE B9 S an il 3.3 frR .

[613.3) &8s il Se k.

LIBRARY ieee;
USE ieee. std logic 1164.all,;
use ieee. std logic unsigned.all;
use ieee. std logic arith.all;
ENTITY cntl0_vhd_tst IS
END cntl10_vhd_tst;
ARCHITECTURE cnt10_arch OF cntl10_vhd_tst IS
constant clock_period:TIME: = 20ns;
SIGNAL clk : STD LOGIC;
SIGNAL counter : STD LOGIC_VECTOR(3 DOWNTO 0);
SIGNAL rst_n : STD_LOGIC,
COMPONENT cnt10
PORT (
clk : IN STD_LOGIC;
counter : OUT STD_LOGIC_ VECTOR(3 DOWNTO 0);
rst_n : IN STD _LOGIC
);
END COMPONENT;
BEGIN
il : cntl0
PORT MAP (
clk => clk,
counter = > counter,
rst_ n=>rst n
);
init : PROCESS
BEGIN
rst n<="'0";
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wait for 100ns;

rst_ n<="'1l"';, —— code that executes only once
WAIT;
END PROCESS init;
always : PROCESS
BEGIN

clk<="1";

wait for clock period/2;

clk<="0";

wait for clock_period/2;
END PROCESS always;
END cnt10_arch;

3.2.4 P ModelSim-Altera RTL {H &

RTL 47 R 905 B AL T RE A7 5 33 A B B £ AT LU SHe i e A0S v A o 1 5 e S AR
AT R IE A P AN RS IR (5 B . A0SR A S AL — 2 5 88 R A S B R R IR 2 Je
AN WY B O B a] DISCEI S ER 0 G . W B SO A e S 1 VHDL 5 SCHF RL K TB 3¢
. AR PLL 48 1P B, 5 B 3 AF 10 2 S0

(1) BEMASCA . i Quartus Prime 8 A H Assigments—Settings F Y Simulation,
SR AN 3. 29 Fr/RET R . 7E NativeLink settings I iy A, S A 3. 30 BT
AN R, BT wew FEEHLL BRI AP 3. 31 BN A B A L BT g A [ L L kB 2T G e 1
WO 42, — MAE -+ simulation/modelsim/cnt10. vht, By Add % 41 52 503 SCHF /Y 35

3.29  BEE ML S



P 3.30 B gl S

K331 M SCRi

i, 7F Test bench name #1 Top level module in test bench HE A MR SC4F 44 Bk, A 451 /R 44
FRA cntl0_tst,

(2) RTL{FE., i Tools—=RTL simulation, Quartus Prime 2= H 35 H ModelSim-Altera
D5 ELAR At N el 3. 32 FR Y ELAE AR,

B 3.32 RTL 5 H45 5
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(3) ModelSim-Altera e 415801 .
& IR i A
s A BIRR RN B LK B A BIAR R R DU b di s 5 A E
PR B F 3 G . B 25 4 0T L R AR — A A P SR s 5B DA B RR R LR O
R 5
s AR AL BT 5 BAR S A B A GRS B R 2R
“ANE bR AT IR E
R TR T AR, v DL BRI 3. 32 Hh A2 B 4 T 4 R Bl BUBR A B G B
Radix /R 455, A o o] DLk £ unsigned 1E S5 R Wow .

3.2.5 8 ModelSim-Altera [JRI{H&E

P BB R G505 B, 4R ZEN LA THER 17 Al DU — bR i R 38 S0 LA
Hh BT LI Verilog 83 VHDL W 3%, b o X 2 SO 02 AR FE 45 A4 T = Z [l % 34
BB Y 9T S i Ok 07 2L, 1 i B9 Verilog B0 VHDL W& AT LSRG B, Z BT A
MTRAF R, RPN GE THARMITENERC S 5477 Z 481 0K )2 70 1 155 78 X6 07 i
KT o LN VTSGR U5 5 DT Bk BRI AT R B g R 6 B g i AT —
WAEE R IC L A WG B AR IR AR R R 2 o e AT B, SR G AR U R S
Covo) I TB i B W32 5847 X0, B DL HE 07 A0 OC 88 14 B Sc . mT LA 2, TR
PFEFIAT T, X+ Quartus Prime A A vo SCHF, B 8B F B L P 2L sdo 3¢
BRI B R B AU T sdo $ER S, 75 2 SCHR vo 3 S0k DL &
TB U, 7 S8 S

B O B AL M 5 05 2L, AR R A 4k 58 B P DASR IR — > Bof 5 0 BLARSE R , 3 Ao
R AL TS T8 ) — 22 {5 B, [F] B ik 25 48 it — > SDF B ¥ bR 7 SCfF (Standard Delay
Format Timing Anotation), SDF B J¥ 5 i¥ i ¥] i FH 76 Verilog i & & i+, 7
VHDL i F Wit w sl 17X M. X T — i it >k v, 77 A 55 %118 SDF
B TE 01T PR A A SO — M g R ) R B A 45 8033, Xilinx 24 A i ] SDF 1E 2 B ¥
PR vE S J 44 Intel 24 RE ] SDO AE R B P bR i SCHF YT € 45 . 7E SDF B J A5 3 SO
HROXT R — NI JZ T TEEAE T 3 A [R] Y JE R, 43 1) 2 SR SE B | /) JE B R R i R AE
S, 75 %5 SDF b v SCFE 47 526 4k U B B, 0 25048 2 R T MR Fh ZE 1, BB AR AR 1T 1Y B
I Bt & 28 SC T I D RE AH 2 A Y B R i L B — D E b 25 A 13 B
iff 19 B B5F 5 8., ZE 3K S B B AT AT DAASE AL 3] Ll A 22 30 S B L B 1R A7 2R o X038 SO m e ), 475 L
s B ERHE B . T WSO vo RSO LA K TB SO L B S B SO sdo CR AR
FEAD . T B S

HUP RS 3. 2.4 1. (EFH WA 3. 31 B 78 FUI0 o 2B AT 18 i B e SR 18] 3. 33
B

TEHEAT 105 B Z /T VHDL &3t 30445 #£17 EDA Netlist Writer #:4F , 4815 K 2
F A, KB NG B Tools— GATE level Simulation, Quartus Prime <= B 30
ModelSim-Altera {j EL&% . 3 HH 4118 3. 34 Fros 05 BL45 5L, B ol LUE 208 B 7
IR th 7 B — B i oA kAR R Ak,



K 3.33 TR HEKHE

B 03.34 TR HL

3.2.6 Sl Ee

PiESE UG FF B Bt IS A . A EC S IR B a2 R Bt b i i A R 15 S R e
FNEAE b G SEAS T, JF 388 1 | A 0% R S s o R P A R R A L 0T DA ) AR AR
P S B D E 1Y . FEAS I T AE S 1 AR AR RS 4 D RSN
SEBRAR B B iy A5 B S5 T 2 40 S T OGS S0 I A e AR A A A e S A R R 4 S RO
RS S 3B ' T A AR IR A A R 2 ) T R A S I TE D RE .

B Assignment—Pin Planner # {41 & 3. 35 i/~ B % 1. 7E Location SR g5 5
ARG Z XTI, #% BRIEL 3. 35 4% T 25 A% b A th o A7 7 e . 58 i1
3 B IR B G i AR

¥ 3.35 Pin Planner Z3fic & 0
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3.2.7 DMERE

LR WA HDL iR 5 /5 B 5 5 oy fe A 19 5 80 3R 17T S RAM, fiih % 55 kA 12
BT B OCR PRI ZOR B MR T B i e R i 6 MR L . 458
R B S bR & EDIF M 2. SCPFJE 208 % 8. edn,. edf .. edif, ZRG W& BR 7 &
HDL B F 5] AT 54 5 8 B A7 A7 f 55 I 7P 2 850 840 5 FPGA K54 14 Fl 5 ih
(Primitive) , bl LUT .BRAM ,DSP48, £ & PowerPC,PCle 55 i A H , DL K ixX B He 1)
R RAE R

Quartus Prime ) Analysis®& Synthesis 32 #F VHDL 1987, VHDL1993 F1 VHDL2008
PRUE, X 26 R fE 1Y ] fF Assignment — Setting —> Analysis&: Synthesis settings > VHDL
Input F1E . BR T QUARTUS PRIME HiiF 25 & THANEGRZH = I L& TR,
4 Synopsys (Y T Synplicity) i Synplify, Mentor Graphic i Precision,

BEAT O3B 5 255 n] LABR o PRl T H A e B2 ) 5 A R AT,

3.2.8 WmE5m%

JIT V8 A Jry 2 i 32 4 X 3R v i) S D B AR )2 B T S B GE i B FPGA YK 4 [
A REAE S5 L A SR B 25 6 TR T A B 4 5 R CFE o B RN T AR P A O TED SE R AR K. PRI A
AR TR MR AT R I EEAG A ] FPCA A & Y & b i 2 92 0, & BROE B 0% 2 & D oo i)
74 #2 . Quartus Prime #4114 Fitter(Place & Route) .38 ML B /ML . 85— 12 #H
PR B TE B U 1) 38 B B TN B DLW R AR IR L B W H S B A Y B AR S,
R PR BT AW A R A L 2 7E B AR a4 1R 000 2 35 i 20 IR AL A ik
T WA BCE AR A R &2y H s T4k, TR0 E AT 7E Assignment— Setting—
Fitter Settings JEI 1 #E 1715 & .

3.2.9 BURE

TR g Pl S L 3 T R B AT g g A B B T AR UE . it BE T Eh e
B A2 S A A R R M. Quartus Prime 9 B2 #8 7210 90 7%
AT & Intel A F A CPLD.FPGA FIEC & 2514 . 40 f2 B0 B SO R an e 3.2 A,

#F3.2 mEXHBKX

3 FPGA CPLD e & 451 ERATIC AR
SRAM Object File(. sof) YES — — —
Program Object File(. pof) — YES YES YES
JEDEC JESD71 STAPL
YES YES YES —
Format File(. jam)
JAM Byte Code File(. jbe) YES YES YES

By PSE F S X A AT 55 A

Programmer ST . 41 & 3. 36 Fiw,
P B 22 A Hardware Setupe JEAT SR AR A5 % &, W R4 2 4% 15, ) 7 50 B 3L 1
T $E USB-Blaster[ USB_D T, 4018 3. 37 Fin .

T JF Quartus Prime



¥l 3.36 Quartus Prime Programmer 5T

& 3.37 i

B4 5 S S T R B A A L g AR B B R R 3,36 A Lo RIS Rk B,
AP JTAG i3, Intel 7] 4 B2 3 28 0 b 245 4 Fhgu A, 03k 3.3 iR,

*3.3 HEHEX

Quartus Prime Programmer . L
S T FPGA CPLD [GREE 2L FRAT L AR
JTAG YES YES YES —
Passive Serial (PS) YES — — —
Active Serial(AS) — — YES
Configure via Protocol(CVP) YES
In-socket Modes(ISM) MAX I &R 5k YES YES

Yo P A 3 6 5 T B 4 R SO, T 1 3. 36 A Add File 34, 76 53 4 11
il E LA P AY 9 A2 SO —— B AE TR Br 78 SC 43¢ output_files H7 DL sof 1 J5 4% A9 Bic & S04
AR ERE counter. sof U, [R B ) 38 5 SCA4: %) W AY Program/Configure, x5 #iifi & 3. 36
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H Start FiEH AT AR EC B 220 A I RE 4% 100 Y0 I 3ROR T 58 WA ORGP AT LAY
I3 AR aTI

3.3 Quartus Prime B9 IP & H

Intel 24 A] By Quartus Prime 3 F $2& L P92 Th GE AL P . 4 9% 9 LPM 2 I fig 5 Bk
(Megafunction/LPM) W3k 3. 4 iR . T B AU A 1P f1 AMPP 1P £ (MegaCore) , 4l
3.5 iR W E AR ST BE LA XL 4 D A I

#* 3.4 Intel Quartus Prime 2t E R 2 Th &

S Zﬂ £

AR S0 N5 e TR A LPM SR 5 AR

i FL15 2 B 2 Ar AL LPM 1] e 8L

A0 45 B 4 BRI &2 (CDR) L 8 A 28 (PLL) L SUERHE 3# % (DDR) L T JK £ Yt & £

Vot (GXB) \LVDS Bl 2870 % 2 28 PLL 1 97 e B R 5 372 20 Bl 4
At i 2 1 A FIFO partitioner , RAM Al ROM %2 Iy fig 455 ¢
PR BRSSO T 4770 1 LPM A7 25 R 4L
% 3.5 Intel Quartus Prime 12 £ MegaCore
HESRREYISIES ST S e ORISR (BUUSLELES
FIR UTOPIA2 PCI MT32 Nios & Nios I
FFT POS-PHY?2 PCI T32 SRAM Interface
Reed Solomon POS-PHY3 PCI MT64 SDR DRAM Interface
Virterbi SIP4. 2 DisplayPort FLASH Interface
Turbo Encode/Decoder SONET Framer DDR1/2/3 UART
NCO Rapid 1/0 Memory I/F SPI
Color Space Converter 8B10B HyperTransport Programmable 1/0
FIR [l PCIE1/4/8 SMSC MAC/PHY I/F
QDRII+MEM IF HPS
RLDRAM MEM IF

ARNTHE 3.1, 3 T 4 AL FE R LA LR clk 5 I 22 Dh e R PLL A,
X Quartus Prime H{ 22 DI RE A9 Jr LA . A1 AT LRI AT Quartus Prime 3004 Y
IP Catalog & B R & L B o = DI BEBI L, B2 1T 1P Catalog & PR 4% ¥ ZE4F Quartus
Prime %1 N 5.5 Tools—IP Catalog ¥ 5 a¥ M PebE T H 424l S 78 5/ S o b an 18] 3. 38
Rk, IWEEHA A LS TP A TIRE .DSP % 1 P A% R4 i 245 LA 1 2%
RSN B A K2 &) TP, iy T2 80 — WA I B 55 — A 1 00, By Nexe #i2 #1311
&l 3.39 s 1,

TEE 3. 38 vz ST 0y Ao O 3 FR AR LA M B 2 DI RE AL H, L # PLL B, 7E Basic
Functions—>Clocks,PLL,Resets>PLL—>ALTPLL.i% 5 #%+#: VHDL, % H B R P T
T JUT AE SCAF Je BB 24 R 44 o0 my_pll, 48l 3. 39 izn . By OK # 4, 3 an &l 3. 40 iR
WEEIE,



[ 3.38 IP Catalog ¥ 51 & 3.39 ¥ PLL

3.40 JH MegaWizard ¥ & pagel

i ® PLL B, 76 &l 3. 40 % 1 H inclkO A 3 AR H5 A 1 5 PR 00 38 B, A B % & R
S50MHz, & 3. 40 AT LI A W, & PLL 3L/ 2 12 25, DUF e B AR P8 5 0 75 SR AT e 5 1
U], Hidy Next #4105 an &l 3. 41 iR iy % H

B 2) 1 3. A1 s B 1 v (e 301, o Ak 75 AR S B I 00 1 8 . By Next %41, B3
WH page6, WAl 3. 42 iR,

95



96

3.41 MegaWizard X 'H page2
TEE 3. 42 % A Al DL B AR S i s i B e S MRAR G s Tl IR I R R
AR T 5 —FPE LT Enter output clock frequency . B2 1% B AH T 19 i 35 R 1,
AT S MHz, 55 R a] L2 B X BB A7 A5 40 L 43 0 2R R AT B o A R L AR
18] v 3 R 5 — b BBz 1R B B B AR 0. 002MHz, W 3. 42 s,

K 3.42 MegaWizard % & page6



TEWE 3. 43 B TP Az i) de i — 25 P o] DUAR 905 75 X A 1 %) S 45 20 1 L SC
PRI GEBA N 3. 6 T . Al T R B ] 7 U AT B h i LB A) ik % . bsf SR, R
J& ¥ty Finish #2261 58 g 1P AR A%,

*& 3.6 MegaWizard % H 2 38

SR i Ui o
%, bsf Ji 3L ] S B i 0 P A9 4 5 S
%, cmp VHDL # 3 H1 o 4 75 BH SC 4
* ., vhd VHDL & i b 5 4k 1 35 2 S
* v Verilog HDL % 31 #5241 4k 18 5 2% Sc
* _inst. vhd VHDL & i1 52 4 4k 1 AR
* _inst. v Verilog HDL & i} H 52 6] £k 58 45 bz

K 3.43 MegaWizard % B pagel?2

FTIF 3. 1.3 1 TR SO, WUk 25 1 A XSRS i AR 0 1) 2 D BE AR B my_pll Il A %
JEERE A S QR 3. 44 TR . BRJE Gk S PR LA A DR A 4R IR 2008 D S HE L R 3R E
FPGA W78k, W A H VHDL #4730, 75 22 H o0 4 5 4k 78 40k A= i i) 1P 72 )
REREH AN A TR SO,

3. 44 HnA my_pll J5 i) 7 B &
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3.4 SignalTap [ B#E 7B A

SignalTap Il &% SignalTap Il Logic Analyzer, /&% — 8 &R G 2 L B, 7] DL #%
V7R I AE 5 B AE RGBT b i B A AR Z [ i A BLAE ] . Quartus Prime 84
AT AR B2 AR A5 5 TR a4l R A i ], DL S B R 2 D B A . i AT D BB ) £ 4
MBS B A7 g B it JTAG 3 144 3% & SignalTap [l Logic Analyzer, 82 % 1/0 5]
DAL SN 58 32 6 03 A A B A A5 P o K S i i 42 ik 25 TR Bt

Signal Tap 13/ B 52 B 88 4 J 2802 76 TR H 5] A Megafunction # i ELA (Embedded
Logic Analyzer) , LA Tl 45 15 2 1) B B R A SE B0 , FEAE6E T FPGA B b RAM %Y, K5
il iF JTAG 1£3% 7] Quartus Prime 30#87. A W, ,SignalTap [ S22 78 TREE AN IDA T 4%
BRGNS B LA Signal Tap I 75 22— % @904, B S5 /& 2 48 900 (ELA) , O
RAM, QR T2 th A 1) RAM BE il 358 2 W Signal Tap 11 — AT DR B 2 U
AHRL AN FPGA B8 O gk TR FE/R W i Af H SignalTap 1111,

SignalTap I fE55 A ANE 3. 45 N,

& 3.45 SignalTap Il 1T55 i 2

(1) B/DWEEZE—A5EEA FPGA BT T RS, DL L AEWE F 48] FPGA #34Frh b F1 78 £k
P,

(2) . stp SCPFTEZ TR P a7 ik A B 3 A0 BT 30, FE AT A DG & L A 46 46 o R 4R
B SRR BE L ik 55 1 AE At A 2l 2 RO RS IR A 55

(3) MRAET 2 TREHAAT R, 245 — UK 2 38 0 B A0 A B AR b, 5038 X 2 4 55
WA S5 B S B AT T 38 KBl 1 an s o 1 2 W W0 B4 B A 55 IR 4 B AT 4 2R o
k. XA SignalTap [1 43t L6 AR W By J2 38 17 A e 0, 4 40 25 A 35— fih 2% 2% 4, )



AN B
(D B oA EZESIBET FEE FPGA #0F .83 JTAG BefEkisfr it a4 e .
(5) i IR fish A S A 1), 22 48 0 A A4S Lk L SR 4 3 B9 B8 1 4% 3% B SignalTap 11 SO &
H. HPfEIRE DT A& A o RAE 3B i ) R
(6) AR FI T 75 & BT 2l 1IE T R A, SRR L R IR 40 e TORR TP 2 g e T A 2
il R A PRI AR GG R s A R D0 R 0 B S R R Sk 2 SR A PR S R Al ) R R
T .
AT LA SCAR 7 BT 2 i s o i 4T d B GrE B b g4k T R T A9 PLL 854
W), FIH SignalTap [l FEL RIS TRUT
(1) fF Quartus Prime {4 ¥ 1% £ 58 BAFE File—
New, 1£ 58 H ) New X} % HE # % £ SignalTap Logic
Analyzer File, N&l 3. 46 Frn. i 55 anial 3. 47
ARy SignalTap [15 1. H P75 4 SignalTap [13¢
PARAE R TR H R,
(2) TEMH SignalTap [ 3% % 5 B AL 47 508
RAEZ R e NI B R A B, PR R 38 A A B A
SETERT B TR AR, M W 2 R 44 R il Bh
Ve Ry RAEm 4, B 3. 47 FLim b S 80 R IX I
clock A4 X} 7 i 0 W2 422 41 [~ L 5 AN & 3. 48 B AR 1)
AR
B E T Filter 1 JE $£ I & Pins. all, B 5
&l 3. 48 H List #4082 78 17 2 A& R X8 h fr 5
AT DA S 45 5 19 a5, B TR P iy P clk 7E2H
KRAEAF 5, 2 vh 5 B v A A > 4 E1RE B ph e v
FMDC B, B OK Hefll, 5 F ok SURREvR R, (9046 FHEE SignalTap 1At

3.47 SignalTap Il # i
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K 3.48 TEEERASED

FREREEYE T 855 T 68 R AR ECE I B R A 0~ 128K, A JL I SR A IR
(Sample depth) % B & 128K, 7 Trigger £/, Trigger position (filt & v ) 7] DLk £ fih %
57 B A5 B B He ] X L% $E Pre trigger position,,

SRR B G BRI S . 7ER] 3,47 ZEME SR Setup ARZE DL FE Setup bk
s PR ZE B L 3 Node Finder XF3EHE (% b5 45 5T A A — 47 K (4 $2 78 Double-click to
add nodes: X HFHMTT S {E S ). 7 Node Finder Xt G #E i) Filter 31 3 A %6 # Signal Tap
Il : pre-synthesis 8% SignalTap Il : post-fitting, £ Look in X 3EAE H148 & JZ K , B List %
AT 5. 1E Nodes Found HEFEZ A STP SO AGTT s ol gk, B s “>7 Fe dlK 1k
FERYT B ZR il 3 Selected Nodes 1, J# 5 a0 3. 49 Fras,

3.49  FREULEET SR

<

M P 2R B 3. 49 i B il & 251, fil & 2% 1 0 1 mT DA B P A A8k ok i
AT R B IRAAF S B A b ke S5 . M 25 A8 43 F Basic I Advanced Piff, 7E Basic
filh % Z& A Don’t Care Rn AE(H 5 N E Y fil % ; Low FKRLHLFfil % ; Falling Edge
Fn PRI AL s Rising Edge £/8 L% 5 High /R @il % 5 Insert Value &4
BEAF T WRAE , RoR BEAF 5 M ILER il % . AH]#%E#E Don’t Care,



(3) — P15 B 58 Wi R g TR

(4) TEIE] 3. 47 1 JTAG 450 B X 828 5 SOF Manage 2 b 0 W 3 611 [ T2 /e
B, il TR L & T #oas o 1, ol AL JTAG #E 2 R85 1 I
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